
InterGO Tour
Welcome! Get ready to visit computers in Japan, Australia, and all over the world!
You'll get the most out of InterGO if you take a few minutes to go through this hands-on tour. Learn the most 
common things you do on the Internet, including searching, sending and receiving electronic mail, accessing 
newsgroups and files on computers, and more! With the protection of KinderGuard, children can do all this 
without parental concern.
There are some things you should know before you start the tour. (Click the underlined blue words to go to the 
next topic.)
InterGO, Cybrarian, and KinderGuard are trademarks of InterGO Communications, Inc. Other brand names are 
trademarks or registered trademarks of their respective owners. See the copyright information in the main help 
for additional information.
Copyright © 1995-1996 by InterGO Communications, Inc. All Rights Reserved.



Things You Should Know Before You Start the Tour
InterGO must be set up before you take this tour. An adult must read the booklet that comes with InterGO 

and follow the instructions to set up an administrator, add users, assign passwords, set up mail, and so on. If 
InterGO is not yet set up, close this window and read the booklet.

If there is more text in a window than fits, you can scroll to see the additional text. You can scroll down by 
clicking below the scroll box in the scroll bar at the right of this window or press the Page Down key on your 
computer keyboard. To scroll back up, click above the scroll bar or press the Page Up key. Note: If the text fits in the
window, there is no scroll bar at the right of the window.

To go to another topic, you will click a button or click words that are blue and have an underline. If you 
click terms that are green and have an underline, such as Internet, you get a definition of the term. Click again 
when you finish reading the definition.

You can make this type larger.
Sometimes this window may overlap InterGO windows. You can move windows so that you can see both 

this window and InterGO.
After this tour you can choose the areas you want to learn more about and start using InterGO to    access 

the Internet.
All set? It's time to start the tour!
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Skip to the Tutorials



Making Type Larger
You can make the type in this tour larger.
1 Click the Options button at the top of this window. The Options menu opens.
2 Click Font. A submenu opens showing the choices.
3 Click Large. This type becomes a larger size.
4 Click the Back button at the top of this window to return to the previous topic.



Moving Windows
You can move this window and InterGO windows so you can see what you wish.
1 Move your mouse pointer to the title bar at the top of the window you want to move.
2 Press and hold the mouse button.
3 Move the mouse. As you move, the window moves.
4 When the window is where you want it, release the mouse button.
5 Click Back at the top of this window to return to the previous help topic.
Note:

If a window is maximized (covers the entire screen), you cannot move it. You can make it smaller by double
clicking the title bar. To maximize the window, double click the title bar again.



Using the Shortcut Menu
The shortcut menu is a quick way to select commands.
1 Point to text, an image, or an area of a dialog box.
2 Click the right mouse button. You see the shortcut menu containing commands appropriate for what you are 

doing.
3 Click the command you want.
4 Click Back at the top of this window to return to the previous help topic.
Tip

Click away from the shortcut menu to close it without choosing a command.



Starting the Tour
InterGO presents four views of the Internet as scenes.

The Desk
The Library
The Newsroom
The Treasure Map

In each scene, you click once on what you want to see. The Desk is home base, the scene you see when you first
run InterGO.

Continue the tour.
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Skip to the Tutorials



Starting the Tour
You need to run InterGO and make sure you are at the Desk.
1 Run InterGO if it is not already running.
2 If more than one person is set up to use InterGO, the Choose User dialog box appears. Click your name to 

select it and then click OK.
3 If you have a password, the Enter Password dialog box appears. Type your password and press Enter.
4 The Desk has a globe. If you do not see the globe, click the Scene menu at the top of the InterGO window, 

then click Desk.
You begin by getting familiar with the scenes. Please wait to click the objects in the scenes until after the 
tour. Then you'll have the opportunity to use all of InterGO's features.

5 Tour the Desk.
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Skip to the Tutorials



Touring the Desk
Hints describe the active objects on the Desk (the ones you can click) as you move your mouse over them.
1 Click the title bar at the top of the InterGO window to make the window active. Its title bar changes color 

when it is active.
2 Move your mouse pointer to the telephone. A hint tells you the telephone connects you to your Internet 

provider.
Remember: Please don't click anything yet.

3 Move the mouse over each object on the desk. Note: You probably have to move this window to see some of 
the areas.

The lamp displays helpful tips on using InterGO.
The globe opens the Internet browser.
The diskette holder opens the File Transfer window.
The address book opens the Address Book.
The letter opens the Mail window.
The Library button changes to the Library scene.
The Newsroom button changes to the Newsroom scene.
The Treasure Map button changes to the Treasure Map scene.

4 Continue the Tour.
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Skip to the Tutorials



Touring the Desk
The menus at the top of the InterGO window let you choose commands.
1 Click the File menu to open it. Click Set Up to see the submenu. When you set up your Interests, InterGO puts

books that match your interests in the Library.
2 Point to the Search menu. It lets you find a subject on the Internet or in the encyclopedia or dictionary.
3 Point to the Desk menu. It is another way to select items on the desk.
4 Point to the Scene menu. It lets you move between scenes, the same as clicking the buttons at the lower left.
5 Point to the Help menu. It lets you run this tour and find help about every aspect of InterGO.

The easiest way to get help is to press F1.
6 Click About InterGO. The browser opens a page with information about your copy of InterGO that may be 

useful if you need to contact Customer Support.
7 On the browser File menu, click Close. You return to the main InterGO window.
8 Tour the Library.
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Skip to the Tutorials



Touring the Library
You use the Library to store Internet pages that you want to return to quickly.
1 Move your mouse pointer to the Library button and click once to see the Library.

The Library has several bookcases. The Reference bookcase contains several books, including enhanced 
versions of The Columbia Encyclopedia, The American Heritage Dictionary, Roget's Thesaurus, the InterGO 
World Atlas, and the InterGO Free Library.

2 Move your mouse pointer over the books to see their titles.
3 Move this window to the left side of your screen.
4 Continue the Tour.
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Skip to the Tutorials



Touring the Library
1 Notice the name of the current bookcase at the upper right of the Library. You can click the down arrow to the

right of the text box to see what bookcases are available, then click a name to show the books on that 
bookcase.
You can create additional bookcases and add books (interesting Internet pages or search results) to any 
bookcase.

2 Move your mouse pointer to the globe in the computer screen at the lower right of the Library. A hint tells you
the globe accesses Library Management.
The buttons at the bottom of the Library let you return to the Desk or go to the Newsroom or Treasure Map. 
Note: You probably have to move this window to see the buttons.

3 Tour the Newsroom.
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Skip to the Tutorials



Touring the Newsroom
The Newsroom lets you group related newsgroups, mailing lists, and Internet pages into news monitors.
1 Move your mouse pointer to the Newsroom button and click to see the Newsroom.

The Internet has over 12,000 newsgroups. In the Newsroom you identify newsgroups you are interested in 
and group them in news monitors. You can also put Internet pages and mailing lists in the news monitors.
Some of the news monitors already contain related newsgroups, with pictures and descriptions indicating 
their subject.

2 Check the hints for these areas of the Newsroom. Note: You probably have to move this window to see some 
of the areas.

Any clock to set up a city and time zone.
Any monitor to set up and access newsgroups.
News Catalog button    to find cataloged newsgroups.
Search button to find newsgroups on specific subjects.

The Newsroom also has buttons for the other scenes.
3 Tour the Treasure Map.
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Skip to the Tutorials



Touring the Treasure Map
You use the Treasure Map to purchase accessories, take off to random pages, play games on the Internet, and 
explore hundreds of Internet pages.
1 Move your mouse pointer to the Treasure Map button and click to see the Treasure Map.
2 Check the hints for these areas of the Treasure Map. Note: You probably have to move this window to see 

some of the areas.
The Books to shop for reference books for the Library.

The Pinball Game to play games on the Internet.
The Rocket to go to random cool pages on the Internet.
The X to go to the Virtual Village.

The Treasure Map also has buttons for the other scenes.
3 Move your mouse pointer to the Desk button and click to return to the Desk.
4 Choose what you want to Learn.



Choosing What You Want To Learn
Choose what you want to learn using the Contents.
1 Click the Contents button at the top of this window. The Help Topics: InterGO Tour window opens. It lists 

subjects you can learn more about.
2 Double click a book to see the topics about that subject.
3 Double click the topic that describes what you want to learn. The tutorial appears.
Tip

Press F1 at any time you are running InterGO. The help topic that appears relates to your current task.
{button Tour,JI(`>splash',`IDH_CONTENTS')} Restart the Tour



Connecting to the Internet
When you run InterGO, it offers to connect to your Internet provider. If you do not connect then, InterGO offers to
connect you when you do something that may require Internet access, such as opening the browser or the Mail 
window. If you wish, you can connect to your Internet provider using the telephone on the Desk.
1 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
2 Click the telephone. The Connect to the Internet dialog box opens.
3 Click your Internet provider to select it.
4 Click Dial. InterGO dials your Internet provider and connects you to the Internet. A dialog box shows the 

progress of the connection.
5 Learn about disconnecting from the Internet.



Disconnecting from the Internet
You also can use the telephone to disconnect from the Internet.
1 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
2 Click the telephone to see information about your Internet provider. The Connect to the Internet dialog box 

opens.
3 Click your Internet provider to select it.
4 Click Disconnect. InterGO disconnects from your Internet provider.
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Adding People to Your Address Book
The Address Book lets you record names, addresses, E-mail addresses, telephone numbers, and company 
information. With InterGO, you only have to enter an E-mail address once. You can address your E-mail using 
either a person's first and last name or a nickname.
The Address Book starts with one address: Customer Support, with a nickname of Customer Support. You can 
add additional names.
In this tutorial, you add the information for a fictitious person, John Dough. You can use the same steps to add 
other people if you know their E-mail addresses.
1 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
2 Continue adding people to your Address Book.



Adding People to Your Address Book
1 Move your mouse pointer to the Address Book and click once to open it. Note: You also can open the Address

Book by clicking the Address Book button in the Mail window.

2 Click the New Entry button  to open the Personal Information dialog box.
3 Type John. It appears in both the First Name text box and in the Nickname text box.
4 Press Spacebar or Tab to move to the Last Name text box.
5 Type Dough. It appears in both the Last Name text box and at the end of the Nickname text box.
6 Continue adding people to your Address Book.



Adding People to Your Address Book
1 Press Tab to move to the Nickname text box.
2 Type John to replace the text in the box. You can use any name you commonly use to refer to the person, 

such as Mom or Bobby or Boss. You can type the nickname to quickly and easily address E-mail.
3 Press Tab to move to the E-mail Address text box.
4 Type JohnD@company.com. Capitalization does not matter in E-mail addresses.
5 Click in the Company text box and type Company.
6 Click OK. John is added to the Address Book. When you address an E-mail to John, InterGO will complete the 

full E-mail address.
7 Click OK to close the Address Book.
{button Learn,JI(`>proc',`IDH_Composing_and_Sending_E_mail')} Composing and Sending Mail
{button Learn,JI(`>proc',`IDH_Receiving_E_mail')} Receiving Mail
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Composing and Sending E-mail
In this tutorial, you send an E-mail message to John Dough, the entry you added to the Address Book in the 
tutorial on adding people to your Address Book. (If you send the E-mail to John, after a while you'll get a reply 
that there was a problem delivering the message, which makes sense because there is no such address. If you 
send mail to someone else, they'll get it in a few minutes.)
You can use the same steps to compose and send E-mail to other people if you have added them to the Address 
Book or know their E-mail addresses.
1 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
2 Move your mouse pointer to the letter and click once to open the Mail window.
3 Continue composing and sending E-mail.



Composing and Sending E-mail

1 Click the Compose button  to open the Compose window.
2 Type John to send the mail to John Dough. You do not have to type the E-mail address or open the Address 

Book because InterGO expands the nickname to the complete Internet address. Note: You must have set up 
John in your Address Book for this address to work.
If you want to send this E-mail to someone instead of John, type their nickname or their full name as you 
entered them in the Address Book, or type their E-mail address if you have not added them to your Address 
Book. To send this E-mail to several people, separate their names with commas. For example, if you have 
entered the proper information in the Address Book, you could address an E-mail to "Mom, Dad, Jill, Skip."
If you prefer, you can choose who you want to send the mail to in the Address Book. Click To: to open the 
Address Book, then click the person you want to send the message to. If you wish, you can select several 
people. Click OK to return to the Compose window. It shows the people you clicked in the Address Book.

3 Continue composing and sending E-mail.



Composing and Sending E-mail
1 Press Tab to move to the cc: text box.
2 Type someone's nickname if you want to send a copy of this E-mail to them. You can separate multiple people

by commas.
3 Press Tab to move to the Subject text box.
4 Type Test for the subject, or whatever subject you wish.
5 Press Tab to move to the message text box.
6 Type This is a test or anything else you like.
7 Continue composing and sending E-mail.



Composing and Sending E-mail

1 Click the Send button  if you want to send the message. The Compose window closes. When the E-
mail is sent, you receive a message. Click OK to acknowledge the message. You return to the Mail window.
If you are composing mail and are not connected to the Internet, InterGO saves your mail. When you connect 
and open the Mail window, InterGO offers to send the mail. If you are charged for your time connected to the 
Internet, it is less expensive to compose offline and connect only to send and receive E-mail.

2 Click the Sent folder to show the E-mail messages in it. It shows the E-mail you just sent. Note: If you have 
not yet received the message that the E-mail was sent, click the Outbox folder to see the E-mail.

Tip
If you wish, you can leave the Mail window open or minimize it while you work in other parts of InterGO or 

in other programs.
{button Learn,JI(`>proc',`IDH_Receiving_E_mail')} Receiving Mail
{button Learn,JI(`>proc',`IDH_Adding_People_to_Your_Address_Book')} Adding People to your Address Book
{button Learn,JI(`>proc',`IDH_Connecting_to_the_Internet')} Connecting to the Internet
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Receiving E-mail
InterGO automatically checks once every ten minutes to see if you have received messages. You also can check 
at any time.
1 If the Mail window is open, go to step 4.
2 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
3 Move your mouse pointer to the letter and click once to open the Mail window.
4 If the Inbox folder is not open, click it to open it. If you have messages, they are normally in your Inbox folder.
5 On the Message menu, click Send/Receive Now. After a moment, you may receive E-mail. As InterGO checks 

to see if you have E-mail, it shows the progress at the bottom of the Mail window.
6 Continue receiving E-mail.



Receiving E-mail
1 To display a message, double click it so it appears in the Display Mail window. There are buttons at the top of 

the window for common actions. Point to a button to see a hint describing what it does.
2 On the File menu, click Close. The Display Mail window closes and you return to the Mail window.
Tip

If you wish, you can leave the Mail window open or minimize it while you work in other parts of InterGO or 
in other programs.

{button Learn,JI(`>proc',`IDH_Composing_and_Sending_E_mail')} Composing and Sending Mail
{button Learn,JI(`>proc',`IDH_Adding_People_to_Your_Address_Book')} Adding People to your Address Book
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Finding Information on the Internet by Subject
The InterGO browser brings the World Wide Web to your desktop. In this example, you search by subject for 
information about weather.
1 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
2 Move your mouse pointer to the globe and click once to open the InterGO browser.

The browser opens to the main page of the Research Resource, if it is your home page, which is located on a 
computer in Texas. This topical index is a fast way to find the information on the Internet. The InterGO 
Communications staff has visited, described, and cataloged every page in the Research Resource.

Note: You can return to this page at any time by clicking the Home button  if it is your home page.
3 Continue finding information on the Internet by subject.



Finding Information on the Internet by Subject
1 Click Science to begin surfing. The browser opens a list of scientific subjects. A number in parentheses after 

each subject shows how many Internet links there are for each subject.
Links are underlined words or phrases in a different color. When you click them, you usually go to another 
page on the Internet, either on the same computer or on a different computer somewhere in the world. If you 
have already visited the page, the browser shows the link in yet another color.

2 Click Meteorology to see a list of Internet pages about meteorology.
Each page has a screening age (shown by the icon at the right), a description, a sponsor, and keywords that 
describe the information included in the page.

3 Continue finding information on the Internet by subject.



Finding Information on the Internet by Subject
1 Find the link "National Oceanographic and Atmospheric Administration Weather Page" and click it. The 

browser opens that page, which is on a U.S. government computer.
Note: The Internet is constantly evolving, so what you see may have changed since this was written.

2 Find the link "Latest US Satellite Picture (infrared) with Radar Echoes Overlayed" and click it. The browser 
opens a page on a computer at Auburn University. The page includes a current U.S. weather map based on a 
satellite image and radar reports. You just surfed the Internet!

3 Continue finding information on the Internet by subject.



Finding Information on the Internet by Subject

1 Click the History button  to open the History dialog box. It shows the Internet pages you visited, with 
the most recent one on top. Note: When you run the browser again, you can use the History list to return to 
pages you previously visited by double clicking a page to return to it.

2 Click Close to return to the browser.
3 If you wish, click Close on the File menu to close the browser and return to the Desk.
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Keyword')} Finding Information on the 

Internet by Keyword
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Searching')} Finding Information on the 

Internet by Searching Using Plain English
{button Learn,JI(`>proc',`IDH_Saving_an_Internet_Page')} Saving an Internet Page as a Book in the Library
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Finding Information on the Internet by Keyword
In this example, you search by keyword for weather information on the Internet.
1 If the browser is running, click the Home button  to go to The Research Resource if it is your home page and 

go to step 4.
2 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
3 Move your mouse pointer to the globe and click once to open the InterGO browser.

4 Click the Keyword button  at the top of the page to see an alphabet.
5 Click the letter W to see a list of keywords that start with the letter W.
6 Click the letter combination WE to scroll to keywords that start with WE.
7 Continue finding information on the Internet by keyword.



Finding Information on the Internet by Keyword
1 Click Weather to open a list of Internet pages that include weather as a keyword. Note: It may take a 

moment for pages to download. Messages at the bottom of the browser describe the progress. When the 
globe at the upper right stops spinning, the entire page is available.

2 Find the link "Various Weather Information" and click it. The browser opens a page from a computer in the 
United Kingdom that includes links about weather around the world.

3 Find the link "WEATHER AND GLOBAL MONITORING in Australia" near the bottom of the page, under Weather 
Information and click it. The browser opens a page from a computer in Australia that includes links about 
weather around the world.
Have you really seen information from computers in the U.S., the United Kingdom, and Australia? Yes, you 
have.

4 Continue finding information on the Internet by keyword.



Finding Information on the Internet by Keyword

1 Click the Back button  to open the previous page. You can use the Back button to go back through the 
pages you have seen.

2 Click the Forward button  to open the next page in the sequence of pages you have seen.
3 If you wish, click Close on the File menu to close the browser and return to the Desk.
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Searching')} Finding Information on the 

Internet by Searching Using Plain English
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Subject')} Finding Information on the 

Internet by Subject
{button Learn,JI(`>proc',`IDH_Saving_an_Internet_Page')} Saving an Internet Page as a Book in the Library
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Finding Information on the Internet by Searching Using Plain English
In this example, you search the Internet for information about hurricanes using the Cybrarian.
1 If the browser is running, click the Home button  to go to The Research Resource if it is your home page and 

go to step 4.
2 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
3 Move your mouse pointer to the globe and click once to open the InterGO browser.
4 Click in the Internet Search: text box, type hurricane and press Enter.

The Cybrarian finds Internet pages that contain the word you typed. The word "hurricane" occurs in several 
hundred pages. The browser lists the page title and part of each document.

5 Continue finding information on the Internet by searching using plain English.



Finding Information on the Internet by Searching Using Plain English
1 Click the link to change your search criteria. The browser opens a page that lets you refine your search.
2 Click the down arrow to the right of the first text box that has "And" in it to see a list of choices.
3 Click "But Not" to select it.
4 In the text box to the right of But Not, type andrew.
5 Click Find. The browser opens a list of pages that contain information about hurricanes but don't include 

Hurricane Andrew. (Also excluded are pages that have "andrew" in them for any other reason.)
You can go to any of the Internet pages that look interesting and surf other subjects.

6 If you wish, click Close on the File menu to close the browser and return to the Desk.
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Subject')} Finding Information on the 

Internet by Subject
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Keyword')} Finding Information on the 

Internet by Keyword
{button Learn,JI(`>proc',`IDH_Saving_an_Internet_Page')} Saving an Internet Page as a Book in the Library
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Saving an Internet Page as a Book in the Library
When you find an Internet page that you like, or anything else that appears in the browser, you can add it as a 
book in the Library. Later, you can return to the page by clicking the book. In this example, you put a book on a 
new library bookcase and then delete the bookcase and book.
To start, you find a page on the Internet and add it to a new Library bookcase.
1 If the browser is running, click the Home button  to go to The Research Resource if it is your home page and 

go to step 4.
2 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
3 Move your mouse pointer to the globe and click once to open the InterGO browser.
4 Click the Keyword button  at the top of the page. You see an alphabet. This is the page you are going to save.

If you prefer, find a page you really want to save.
5 Continue saving an Internet page as a book in the Library.



Saving an Internet Page as a Book in the Library

1 Click the Book button  to open the Book Properties dialog box.
The information in the dialog box is correct except for the Bookcase.

2 Click Add to the right of the Bookcase text box to open the Bookcase Properties dialog box.
3 Type Searching to name the new bookcase. It appears in the Bookcase Name text box.
4 Click OK to return to the Book Properties dialog box.
5 Click the down arrow to the right of the Bookcase text box to see a list of bookcases.
6 Click Searching to select it.
7 Click OK. Nothing appears to happen, but this Internet page is added as a book on the Searching bookcase in 

your Library.
8 On the File menu, click Close. The browser closes and you return to the Desk.
9 Continue saving an Internet page as a book in the Library.



Saving an Internet Page as a Book in the Library
Next you use the book to go to the page.
1 Move your mouse pointer to the Library button and click to go to the Library.
2 Click the down arrow to the right of the bookcase names at the upper right of the window. You see the 

available bookcases. Note: You probably have to move this window.
3 Click Searching to select it. The book you added appears.
4 Move your mouse pointer to the book. A hint tells you the name of the book.
5 Click the book to open the browser to the page.
6 On the File menu, click Close. The browser closes and you return to the Library.
7 Continue saving an Internet page as a book in the Library.



Saving an Internet Page as a Book in the Library
Finally you delete the bookcase and book.
1 Click the globe in the monitor at the lower right of the window to open the Library Management dialog box.
2 Click the Searching bookcase to highlight it.
3 Click Remove. A dialog box asks you to confirm deleting the bookcase and the books on it.
4 Click Yes to delete the bookcase and return to the Library Management dialog box.
5 Click Close. The dialog box closes and you return to the Library. The book and bookcase are no longer 

available.
{button Learn,JI(`>proc',`IDH_Using_the_Books_in_the_Library')} Using the Books in the Library
{button Learn,JI(`>proc',`IDH_Working_with_Your_Bookcases')} Working with Your Bookcases
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Subject')} Finding Information on the 

Internet by Subject
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Keyword')} Finding Information on the 

Internet by Keyword
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Searching')} Finding Information on the 

Internet by Searching Using Plain English
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Transferring Files to Your Computer
File Transfer (also called FTP) lets you copy files between computers on the Internet. In this example, you 
transfer a file from the InterGO Communications computer (FTP server) to the InterGO directory on your 
computer. Note: You must be connected to the Internet to use FTP.
1 If you are not at the Desk, click the Desk button at the lower left of the InterGO window.
2 Move your mouse pointer to the diskette holder at the upper right of the Desk and click once to open the File 

Transfer window. Note: You probably have to move this window to see the diskette holder.
The top part of the window shows files on your computer. The files on the computer you connect to are in the 
bottom part of the window.

3 Click the Sites button  to open the File Transfer Sites dialog box.
4 Continue transferring files to your computer.



Transferring Files to Your Computer
1 Click InterGO Communications to select it.
2 Click Properties to open the Connection Information dialog box.

This dialog box contains the information you need to be allowed to connect to the anonymous InterGO 
Communications FTP site.

3 Click in the Password text box and type your E-mail address.
4 Click OK to return to the File Transfer Sites dialog box.
5 Click Connect. InterGO connects you to the InterGO Communications site.

The progress of the connection is shown at the bottom of the window. When the connection is complete, you 
see the files on the InterGO Communications computer in the bottom of the dialog box.

6 Continue transferring files to your computer.



Transferring Files to Your Computer
You need to change to the proper directories.
1 In the lower area, double click the directory InterGO to open it. After a moment the files in it appear.
2 Click the file RELEASE.HTM to highlight it. (You may have to scroll to see the file.)

3 Click the Receive button . The file transfers from the InterGO Communications computer to your 
computer. You now have the latest version of that file.

4 Click the Disconnect button . A messages asks you to confirm the disconnection.
5 Click Yes. You disconnect from the InterGO Communications computer.
6 On the File menu, click Close. The File Transfer window closes and you return to the Desk.
{button Learn,JI(`>proc',`IDH_Connecting_to_the_Internet')} Connecting to the Internet
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Setting Up Your Interests
When you set up your interests, InterGO adds appropriate books to the Library.
1 On the File menu, point to Set Up and click Interests. The browser opens a page to let you set up your 

interests.
2 Follow the instructions on the page. When you finish, books that reflect your interests are added to your 

Library
3 If you wish, click Close on the File menu to close the browser and return to the scene.
{button Learn,JI(`>proc',`IDH_Using_the_Books_in_the_Library')} Using the Books in the Library
{button Learn,JI(`>proc',`IDH_Working_with_Your_Bookcases')} Working with Your Bookcases
{button Learn,JI(`>proc',`IDH_Buying_Books_To_Add_to_Your_Library')} Buying Books To Add to Your Library
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Using the Books in the Library
To start, you open the book Around the World in Eighty Days by Jules Verne.
1 Point to the Library button at the lower left of the InterGO window and click once to go to the Library.

The Library comes with bookcases already stocked with books.
2 Click the down arrow to the right of the bookcase names at the upper right of the window to see the available

bookcases. Note: You probably have to move this window to see the bookcase names.
3 Click Literature to select it. Books appear on the Literature bookcase.
4 Continue using the books in the Library.



Using the Books in the Library
1 Move your mouse pointer to a book. A hint tells you the name of the book.

You could find the book by reading each of their hints, but there is another way.
2 Click the globe in the monitor at the lower right of the window to open the Library Management dialog box. 

Note: You may have to move this window to see the globe.
3 Click the plus sign  to the left of the Literature bookcase to see a list of all the books on the bookcase.
4 Click Around the World in Eighty Days to highlight it and click Open. The browser shows the book's Table of 

Contents.
5 Continue using the books in the Library.



Using the Books in the Library
1 Click the link to Chapter I to start with that chapter.
2 In the second paragraph, click the London link. The browser shows the encyclopedia article about London.
3 Scroll through the article. It contains links to other encyclopedia articles. At the end of the article are links to 

Internet pages about Boston.
4 Click the Back button  to return to the book.
5 On the File menu, click Close. The browser closes and you return to the Library.
6 Continue using the books in the Library.



Using the Books in the Library
Next you look up Boston in the dictionary and find additional information.
1 Click the down arrow to the right of the bookcases and click Reference to select it. The reference books 

appear, including an encyclopedia, dictionary, thesaurus, and atlas.
2 Move your mouse pointer over the books until a hint identifies The American Heritage Dictionary, Third 

Edition.
3 Click the book. The browser opens the dictionary.
4 Click in the Search For text box, type boston, and press Enter. You see the dictionary entry for Boston.
5 Continue using the books in the Library.



Using the Books in the Library
1 Move your mouse pointer to the word "abolitionist" in the definition and click the right mouse button. The 

shortcut menu showing choices appears.
2 Click Search to select it. A submenu appears.
3 Click In Dictionary to select it. The Reference Search dialog box opens with the word you clicked in the Find 

text box.
4 Click Search. The browser opens the dictionary definition of the word.

Remember that sequence! You can use those steps to look up any word you see in the browser from any 
page on the Internet. The sequence even works for words in E-mail messages if you highlight the word first.

5 Continue using the books in the Library.



Using the Books in the Library
1 Move your mouse pointer to the word "slavery" in the definition and click the right mouse button to open the 

shortcut menu.
2 Click Search, click In Encyclopedia, and click Search. The browser opens the encyclopedia article about 

slavery.
3 Move your mouse pointer to the word "dominance" in the first sentence, click the right mouse button, and 

look up the word in the dictionary.
This definition includes synonyms from the thesaurus that you can click to see their dictionary definitions.

4 Continue using the books in the Library.



Using the Books in the Library
1 Scroll to the bottom of the definition and click the link Roget's II: The New Thesaurus. You go to the 

thesaurus.
2 Click in the Search For text box, type slavery, and press Enter. You see the thesaurus entry for Slavery.
3 On the File menu, click Close. The browser closes and you return to the Library.
{button Learn,JI(`>proc',`IDH_Working_with_Your_Bookcases')} Working with Your Bookcases
{button Learn,JI(`>proc',`IDH_Setting_Up_Your_Interests')} Setting Up Your Interests
{button Learn,JI(`>proc',`IDH_Buying_Books_To_Add_to_Your_Library')} Buying Books To Add to Your Library
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Working with Your Bookcases
In this example, you create a new bookcase, put a book on it, and then delete the bookcase.
To start, you create the new bookcase.
1 Point to the Library button at the lower left of the InterGO window and click once to go to the Library.
2 Click the globe in the monitor to open the Library Management dialog box. Note: You may have to move this 

window to see the globe.
3 Click New Bookcase to open the Bookcase Properties dialog box.
4 Type Temporary in the Bookcase Name text box and press Enter. The new bookcase is added.
5 Click Close to return to the Library.
6 Continue working with your bookcases.



Working with Your Bookcases
Next you search for information on the Internet about money and put the results of the search on the new 
bookshelf.
1 On the Search menu, click Internet to open the Internet Search dialog box.
2 Type money and press Enter. The browser opens to a page with the results of the search.
3 Click the Book button  to open the Book Properties dialog box.
4 Click the down arrow to the right of the Bookcase text box to see a list of choices.
5 Click Temporary to select it.
6 Click OK. Nothing appears to happen. The search results are added as a book on the Temporary bookcase in 

your Library.
7 Continue working with your bookcases.



Working with Your Bookcases
1 On the File menu, click Close. The browser closes and you return to the Library.
2 Click the down arrow to the right of the bookcases. You see the available bookcases. Note: You may have to 

move this window.
3 Click Temporary to select it. The book you added appears. If you wish, you can click on it and see the search 

results and then close the browser to return to the Library.
4 Continue working with your bookcases.



Working with Your Bookcases
Finally you delete the bookcase and book.
1 Click the globe in the monitor to open the Library Management dialog box. Note: You may have to move this 

window.
2 Click the Temporary bookcase to highlight it.
3 Click Remove. A dialog box asks you to confirm deleting the bookcase and the books on it.
4 Click Yes.
5 Click Close to close the Library Setup dialog box and return to the Library. The book and bookcase are no 

longer available.
{button Learn,JI(`>proc',`IDH_Using_the_Books_in_the_Library')} Using the Books in the Library
{button Learn,JI(`>proc',`IDH_Setting_Up_Your_Interests')} Setting Up Your Interests
{button Learn,JI(`>proc',`IDH_Buying_Books_To_Add_to_Your_Library')} Buying Books To Add to Your Library
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Setting Up Newsgroups in the Newsroom
In this example, you put the newsgroup Philosophy (talk.philosophy.misc) in a monitor.
1 Point to the Newsroom button at the lower left of the InterGO window and click to go to the Newsroom.

The Newsroom has monitors that can contain any number of newsgroups, World Wide Web pages, and 
mailing lists.

2 Click the last monitor at the lower right to open the News window for Monitor 8 and the News Wizard dialog 
box. Note: You may have to move this window.

3 Usenet Newsgroup is already selected, so click Next.
4 Click Newsgroup Catalog to select it and click Finish. The browser opens the top level of the newsgroup 

hierarchy.
5 Continue setting up newsgroups in the Newsroom.



Setting Up Newsgroups in the Newsroom
1 Click the link talk to select it. The browser opens a page with information about newsgroups in the talk 

hierarchy.
2 Click the link Philosophy Newsgroup to select it. A dialog box appears asking if you want to add a news 

server. Note: If you have already set up your news server, this dialog box does not appear. Continue with the
paragraph after step 2 in the next topic.

3 Click Yes to open the News Servers dialog box.
4 Click Add to open the Add News Server dialog box.

You must obtain the name of your news server from your provider. It is probably the same as your provider, 
but with "news." in front of it. For example, if your provider is xyz.net, the news server is probably 
news.xyz.net.

5 Type the name of your news server.
6 Continue setting up newsgroups in the Newsroom.



Setting Up Newsgroups in the Newsroom
1 Click OK. The news server is added to the News Servers dialog box.
2 Click OK.

The newsgroup is added to the News window and the messages associated with it are displayed.
Note: Most providers carry only a small selection of the more than 12,000 newsgroups available. Your news 
provider may not carry this newsgroup. In that case, the information after the newsgroup remains "(0 
Articles, Not Updated yet)." If you want access to a newsgroup that your provider does not carry, contact 
your provider.

3 Click the Configuration button  to open the Monitor Properties dialog box.
4 Continue setting up newsgroups in the Newsroom.



Setting Up Newsgroups in the Newsroom
1 Type Philosophy to replace what is in the Name text box.

2 Click the Ellipsis button  to the right of the Image text box to open the Select an Image File dialog box.
3 Click the file WNEWS.BMP to select it and click Open. You return to the Monitor Properties dialog box.
4 Click OK to return to the News window.
5 On the File menu, click Close.
6 In the browser, open the File menu and click Close to return to the Newsroom. The eighth monitor has a 

picture and is named Philosophy.
{button Learn,JI(`>proc',`IDH_Using_Newsgroups_in_the_Newsroom')} Using Newsgroups in the Newsroom
{button Learn,JI(`>proc',`IDH_Setting_Up_the_Clocks_in_the_Newsroom')} Setting Up the Clocks in the 

Newsroom
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Using Newsgroups in the Newsroom
InterGO comes with some monitors already containing sources of information. In this example, you open a 
monitor to see sports news.
1 Point to the Newsroom button at the lower left of the InterGO window and click once to go to the Newsroom.
2 Click the monitor labeled Sports. The News window displays sources of information about sports. Note: You 

may have to move this window.
Newsgroups are marked with a package of newspapers . Pages from the World Wide Web are marked with
a web 

. Mailing lists are marked with a mail folder 
.

3 Continue using newsgroups in the Newsroom.



Using Newsgroups in the Newsroom
Note: You can only open a newsgroup you added to the monitor labeled Sports. If have not added a 
newsgroup to the monitor labeled Sports, click Continue in step 3 and continue with step 3 in the next topic.

1 Double click a newsgroup. InterGO updates the messages in it and displays them.
Note: Most providers carry only a small selection of the more than 12,000 newsgroups available. Your news 
provider may not carry a particular newsgroup. In that case, the information after the newsgroup remains "(0 
Articles, Not Updated yet)." If you want access to a newsgroup that your provider does not carry, contact 
your provider.
The messages are shown in "threads" that discuss the same topic. You can click the plus buttons  and minus 
buttons 

 to show and hide the messages within threads.
2 Double click the first message. The Display Mail window opens so you can read the message.
3 Continue using newsgroups in the Newsroom.



Using Newsgroups in the Newsroom

1 Click the Next button . The next message is displayed.
2 On the File menu, click Close to return to the News window.
3 Double click a page from the World Wide Web. The browser opens the page.
4 On the browser File menu, click Close to return to the News window.
5 On the News window File menu, click Close to return to the Newsroom.
{button Learn,JI(`>proc',`IDH_Setting_Up_Newsgroups_in_the_Newsroom')} Setting Up Newsgroups in the 

Newsroom
{button Learn,JI(`>proc',`IDH_Setting_Up_the_Clocks_in_the_Newsroom')} Setting Up the Clocks in the 

Newsroom
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Setting Up the Clocks in the Newsroom
The Newsroom has five clocks. They show times for cities around the world. In this example, you set a clock to 
show the time for your city.
1 Point to the Newsroom button at the lower left of the InterGO window and click once to go to the Newsroom.
2 Click a clock to open the Clock Properties dialog box. Note: You might want to click a clock that shows the 

time where you are, if one is available.
3 Type the name of your city in the Display Name text box.
4 Continue setting up the clocks in the Newsroom.



Setting Up the Clocks in the Newsroom
1 Click the down arrow to the right of the Time Zone text box to see a list of time zones.

The time zones are shown by their difference from Greenwich Mean Time (London time). For example, the 
U.S. Eastern time zone is -05:00, Central time is -06:00, Mountain time is -07:00, and Pacific time is -08:00.

2 Click a time zone and city that corresponds with your time.
3 Click OK. The clock changes to show the time and city name you chose.
{button Learn,JI(`>proc',`IDH_Setting_Up_Newsgroups_in_the_Newsroom')} Setting Up Newsgroups in the 

Newsroom
{button Learn,JI(`>proc',`IDH_Using_Newsgroups_in_the_Newsroom')} Using Newsgroups in the Newsroom
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Buying InterGO Accessories
In this example, you start to buy books to add to your Library. Whether you buy them is up to you.
1 Point to the Treasure Map button at the lower left of the InterGO window and click once to go to the Treasure 

Map.
2 Click the books at the upper left of the Treasure Map. The browser displays information about accessories you

can buy for InterGO.
3 Follow the instructions to get information about the accessories and, if you wish, buy them.
4 On the browser window File menu, click Close to return to the Treasure Map.
{button Learn,JI(`>proc',`IDH_Playing_Games_on_the_Internet')} Playing Games on the Internet
{button Learn,JI(`>proc',`IDH_Take_Off_to_New_Internet_Pages')} Take Off to New Internet Pages
{button Learn,JI(`>proc',`IDH_Exploring_Internet_Pages_from_the_Virtual_Village')} Exploring Internet Pages 

from the Virtual Village
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Playing Games on the Internet
In this example, you play games on the Internet.
1 Point to the Treasure Map button at the lower left of the InterGO window and click once to go to the Treasure 

Map.
2 Click the pinball game at the lower left of the Treasure Map. The browser displays various games you can play

on the Internet. Click a link to go to the Internet page and play the game.
If you find any games you want to play again, you can add them as a book on your bookcases.

3 When you finish playing, click Close on the browser's File menu to return to the Treasure Map.
Another way to find games to play is to search for games by subject, using keywords, or using plain English.

{button Learn,JI(`>proc',`IDH_Buying_Books_To_Add_to_Your_Library')} Buying Books To Add to Your Library
{button Learn,JI(`>proc',`IDH_Take_Off_to_New_Internet_Pages')} Take Off to New Internet Pages
{button Learn,JI(`>proc',`IDH_Exploring_Internet_Pages_from_the_Virtual_Village')} Exploring Internet Pages 

from the Virtual Village
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Taking Off to New Internet Pages!
In this example, you travel to a page on the Internet you may never have seen before.
1 Point to the Treasure Map button at the lower left of the InterGO window and click once to go to the Treasure 

Map.
2 Click the rocket at the upper right of the Treasure Map. The browser displays a page chosen randomly from a 

list of interesting pages. Note: You may have to move this window.
If you don't think the page is interesting, click the rocket again. If you find any pages you want to visit again, 
you can add them as a book on your bookcases.

3 When you finish looking at interesting Internet pages, click Close on the browser's File menu to return to the 
Treasure Map.

{button Learn,JI(`>proc',`IDH_Buying_Books_To_Add_to_Your_Library')} Buying Books To Add to Your Library
{button Learn,JI(`>proc',`IDH_Playing_Games_on_the_Internet')} Playing Games on the Internet
{button Learn,JI(`>proc',`IDH_Exploring_Internet_Pages_from_the_Virtual_Village')} Exploring Internet Pages 

from the Virtual Village
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Exploring Internet Pages from the Virtual Village
In this example, visit the Virtual Village to find interesting Internet pages.
1 Point to the Treasure Map button at the lower left of the InterGO window and click once to go to the Treasure 

Map.
2 Click the X at the lower right of the Treasure Map to go to the Virtual Village. Click links to explore Internet 

pages on a variety of subjects. Note: You may have to move this window.
You can also search for information by subject, using keywords, and using plain English.
If you find any pages you want to visit again, you can add them as a book on your bookcases.

3 When you finish exploring the Virtual Village, click Close on the browser's File menu to return to the Treasure 
Map.

{button Learn,JI(`>proc',`IDH_Buying_Books_To_Add_to_Your_Library')} Buying Books To Add to Your Library
{button Learn,JI(`>proc',`IDH_Playing_Games_on_the_Internet')} Playing Games on the Internet
{button Learn,JI(`>proc',`IDH_Take_Off_to_New_Internet_Pages')} Take Off to New Internet Pages
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Setting Your Home Page
When you click the Home button  in the browser, it takes you to your home page. That page may be The 
Research Resource or it may be another page.

If it is another page, there may be a link to the InterGO browser home page. Click that link to go to The Research 
Resource.
If there is no link to The Research Resource on the page that appears when you click the Home button, you have 
two choices.

Type the address of The Research Resource in the browser Location text box and press Enter to go to the 
page. The address is http://www.intergo.com/browserhome/home12.htm.

Change your home page to the location of The Research Resource. On the File menu, click Preferences. 
Type the address of The Research Resource and click OK. The address is 
http://www.intergo.com/browserhome/home12.htm.

Tip
You also can go to The Research Resource from the library. In the Reference bookcase, click the book 

labeled Research Resource.
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Keyword')} Finding Information on the 

Internet by Keyword
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Subject')} Finding Information on the 

Internet by Subject
{button Learn,JI(`>proc',`IDH_Finding_Information_on_the_Internet_by_Searching')} Finding Information on the 

Internet by Searching Using Plain English
{button Learn,JI(`>proc',`IDH_Saving_an_Internet_Page')} Saving an Internet Page as a Book in the Library
{button Learn,JI(`>proc',`IDH_Choosing_What_You_Want_To_Learn')} Choosing What You Want To Learn



Double Click
Click the mouse button twice, quickly, without moving the mouse pointer.



Internet
A global collection of tens of thousands of interconnected computers and computer networks. The most common
uses of the Internet are sending electronic mail, exchanging information, and looking at information available on 
computers connected to the Internet.



E-mail Address
The code used by the Internet to identify the recipient or sender of electronic mail. An E-mail address consists of 
an account name and the mail server, separated by the @ symbol. For example, in Librarian@intergo.com, 
Librarian is the account name and intergo.com is the mail server.



Newsgroup
A discussion group about a specific subject. With many newsgroups, you can send E-mail that others can read. 
Some newsgroups have a moderator who determines which E-mail messages are published. Anyone can see the 
messages in a newsgroup as long as their provider carries the newsgroup.



Mailing List
A discussion group about a specific subject, such as scuba diving or dieting. You must apply for membership, 
which is usually given automatically. After you become a member, you send E-mail that others can read, and you
receive E-mail that other members submit. Only members of the mailing list see the messages.



Link
An underlined word or phrase, usually of a different color, shown in the browser. You click a link to go to another 
page. After you visit a page, links to it show in yet another color. Some pictures are also links. Links in InterGO 
are indicated by the mouse pointer changing to a magnifying glass.



Nickname
A name you use to refer to a person. You can type the nickname in Mail’s To: or cc: field, and Mail automatically 
expands it to the complete E-mail address.



Select Multiple Items
In many situations, you can select multiple items.
To select contiguous (sequential) items
1 Click the first item to select it.
2 Press and hold Shift.
3 Click the last item.
4 Release Shift.
To select random items
1 Click the first item to select it.
2 Press and hold Ctrl.
3 Click additional items.
4 Release Ctrl.





Personal Information Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
First Name
Type the person's first name.
Last Name
Type the person's last name.
Nickname
Type the name you commonly use to refer to the person. You can use the nickname to address E-mail.
E-mail Address
Type the person's E-mail address.
Phone Numbers - Location
Click the down arrow to the right of the text box and click a location, such as business, home, fax, and so on. 
Then press Tab and enter the phone number.
Phone Numbers - Number
Type the number associated with the phone location.
Address
Type the person's address.
Company
Type the company the person works for, or other information such as their school.
Title
Type the person's title, or other information such as their year in school.
Department
Type the person's department, or other information such as their school major.



Internet Search Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Find
Type the word or words you want to search for.
Documents
Select to search in documents.
News and Discussion Groups
Select to search in newsgroups.



Monitor Properties Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Name
Type a name for the monitor.
Monitor File
Click the Ellipsis button  to the right of the Monitor File text box. The Select a Monitor File dialog box opens. 
Choose the file you want to use and click OK. Note: You normally should not change the file that contains 
information about a monitor.
Image
Click the Ellipsis button  to the right of the Image text box. The Select an Image File dialog box opens. Choose 
the file you want to use and click OK.
Description
Click a name if you want to set the monitor to one of the configurations that ships with InterGO. The Name, 
Monitor File, and Image are set to the defaults.



Bookcase Properties Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Bookcase Name
Type a name for the bookcase.
Bookcase Access
Click Private if you want the bookcase and its books to be hidden from other users of your copy of InterGO. Click 
Shared if you want the bookcase and its books to be available to other users.



Library Management Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Bookcase List
Shows the bookcases available. Click a square containing a plus sign  to the left of the bookcase to see the 
books in a bookcase. Click a square containing a minus sign 

 to hide the books in a bookcase.
Open
Click to open the selected book in the browser.
New Bookcase
Click to add a new bookcase. The Bookcase Properties dialog box opens.
New Book
Click to add a new book to the selected bookcase. The Book Properties dialog box opens.
Properties
Click to change the properties of the selected bookcase. The Bookcase Properties dialog box opens.
or
Click to change the properties of the selected book. The Book Properties dialog box opens.
Remove
Click to remove the selected bookcase or book. A message asks you to confirm the deletion.



Connect to the Internet Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Connection
The name of the Internet provider
Phone Number
The phone number your computer calls to connect to the Internet provider.
Status
The status of the Internet provider, such as Connected.
Dial
Click to have your computer call the selected provider and connect.
Disconnect
Click to break the connection between your computer and the selected provider.
Create
Click to create a new Internet provider. The Make New Connection wizard opens.
Properties
Click to see or change the selected provider's properties. The Provider Properties dialog box opens.



History Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Visited Documents
Shows, for each page, the title, the address, when you last visited the page, and how many times you visited the
page.
Go To
Click to open the selected page in the browser. You also can open a page by double clicking it.
Properties
Click to open the Document Details dialog box with information about the selected page.
Empty
Click to remove all records of pages you have visited.



News Servers Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
News Servers List
Lists the news servers currently set up. Select one if you want to edit it or delete it.
Add
Click to add a news server. The Add News Server dialog box opens.
Edit
Click to edit the selected news server. The Edit News Server dialog box opens.
Delete
Click to delete the selected news server. You are asked to confirm the deletion.



Reference Search Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Find
Type the word you want to search for.
Search
Click to open the encyclopedia or dictionary to information about the word you typed.



Add News Server Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
News Server
Type the name of the news server you want to add. You must obtain the name of your news server from your 
provider. It is probably the same as your provider, but with "news." in front of it. For example, if your provider is 
xyz.net, the news server is probably news.xyz.net.



Book Properties Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Title
Type the title you want the book to have. If you are saving an Internet page as a Library book, the title of the 
page is automatically inserted.
Location (URL)
Type the Internet address of the page you want to save. If you are saving an Internet page as a Library book, the 
title of the page is automatically inserted.
Bookcase
Click the down arrow to the right of the text box and click the bookcase you want the book to be in. If you wish, 
click Add to create a new bookcase. The Bookcase Properties dialog box opens.
Color
Click the Ellipsis button  to the right of the Color box. The Color dialog box appears. Click the color you want the 
book to be and click OK.



Clock Properties Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Display Name
Type the name of a city.
Time Zone
Click the down arrow to the right of the Time Zone text box to see a list of time zones and click the time zone 
and city you want.
The time zones are shown by their difference from Greenwich Mean Time (London time). For example, the U.S. 
Eastern time zone is -05:00, Central time is -06:00, Mountain time is -07:00, and Pacific time is -08:00.



File Transfer Sites Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Name
The name you typed in the Connection Information dialog box.
Description
The description you typed in the Connection Information dialog box.
Address
The address you typed in the Connection Information dialog box.
Connect
Click to connect to the selected site.
Create
Click to create a new site. The Connection Information dialog box opens.
Properties
Click to see or modify information about the selected site. The Connection Information dialog box opens.
Remove
Click to delete the selected site from the list.



Choose User Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Please Select Your User Name
Click the name of the user you want to log in as and click OK. If the user has a password, the Enter Password 
dialog box opens.



Enter Password Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Please Type Your Password
Type the InterGO password. Click OK and you can start using InterGO.



Connection Information Dialog Box
Tip

Click Back at the top of this window to return to the tutorial.
Host Name
Type the Name of the host. You can use any name that identifies the site.
Host Address
Type the Internet address of the host computer. Internet addresses for host computers often start with ftp., such 
as ftp.teachersoft.com.
Host Description
Type a description of the site. You can use anything that helps you remember why you connect to this site.
Host Type
Click the down arrow and select the Host Type. The most common is Auto Detect.
Login Name
Type a Login Name, if necessary. For most file transfer sites, you can use the name Anonymous, which is the 
default provided by InterGO. Some sites require a different name.
Login Password
Type a password for the site, if necessary. For sites that let you use the name Anonymous, the password is often 
your E-mail address, which is the default provided by InterGO. Some sites require a different password.
Login Account
Type your login Account, if necessary. For Anonymous sites, this is usually not required.
Login Initial Directory
Type the initial directory you want to connect to at the file transfer site, if you wish. If you do not enter a starting 
directory, you connect to the default directory for the file transfer site.






